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Welcome!

There are many resources available to help you install Microsoft CRM on your
Microsoft Windows Small Business Server 2003 installation. If you have experience with
setting up Windows Small Business Server 2003, this Quick Start Guide provides a path
for getting started so that you can quickly move on to exploring Microsoft CRM.

For more information about planning your Small Business Server installation, configuring Microsoft CRM for
your organization, or additional details about steps in this guide, see the following resources:

* Microsoft Business Solutions CRM Implementation Guide and Readme.htm file, available on the Microsoft
CRM Documentation CD

» An updated Chapter 15 “Installing Microsoft CRM Server on Microsoft Windows Small Business Server
2003 " for the Implementation Guide, available from http://www.microsoft.com/downloads (From the
Product/Technology list, click Microsoft CRM, and in the Keywords box, type Implementation.)

« Installing and Securing Microsoft CRM 1.2 on a Windows Small Business Server 2003 Network, available
from http://www.microsoft.com/downloads (From the Product/Technology list, click Windows Small
Business Server, and in the Keywords box, type CRM.)

 Microsoft Knowledge Base Article 870636, Exposing Microsoft CRM to the Internet on Microsoft Windows
Small Business Server 2003, Using ISA Server 2000, available at
http://support.microsoft.com/default.aspx?kbid=870636

* Microsoft CRM on Small Business Center:
http://www.microsoft.com/smallbusiness/products/mbs/crm/detail. mspx

« Support: http://support.microsoft.com/mbscrm

* Microsoft Windows Small Business Server 2003:
http://www.microsoft.com/windowsserver2003/sbs/default.m spx.

Microsoft CRM Editions

Microsoft CRM comes in several editions. When this guide refers to a task that can be
completed only in certain editions, you will see one of the symbols in the following table:

Task can be completed only in Professional editions
(Sales Professional, Service Professional, or Suite Professional).

Task can be completed only in Sales editions
(Sales Standard, Sales Professional, Suite Standard, and Suite Professional).

Task can be completed only in Service editions
(Service Standard, Service Professional, Suite Standard, and Suite Professional).

For more information about what is included in each edition,
see http://www.microsoft.com/BusinessSolutions/crm/crm_edition_comparison.aspx.




Complete these steps,
and in less than three hours, you'll be
ready to explore Microsoft CRM

On the Windows Small Business Server

1 Verify Windows Small Business Server Installation Q 10 min
2 Choose Installation & Get License Key @ 5 min
3 Install Microsoft CRM Prerequisites Q 15 min
4 Create Web Site for Microsoft CRM d) 10 min
5 Install Microsoft CRM Q 30 min
6 Prepare Microsoft CRM for use @ 15 min
7 Install Microsoft CRM-Exchange E-mail Router @ 15 min

On the Client Computer

8 Set Up Client Computers Q 10-60 min

% Explore Microsoft CRM




Verify That Windows Small Business Server Installation
Meets Microsoft CRM Requirements

This section assumes you already have your Windows Small Business Server 2003 Premium Edition set up.
If this is not the case, see the resources listed in the “Welcome” section at the beginning of this guide.

The following table shows the hardware recommendations for running Microsoft CRM:

Dual 1.8-gigahertz (GHz) Intel Pentium 4 Xeon or comparable processor
1 gigabyte (GB) of RAM minimum, 2 GB or more recommended

72 GB or larger

Hard Disk . . . .
Hard disk configuration matches backup requirements

An external firewall, or if using the built-in firewall, two network cards

. Ensure that your server has the option to add RAM. Adding RAM is an easy and inexpensive way to
Tips: boost performance as usage expands.

\

Consult early with your IT Partner for backup options, as some backup options require additional disk
partitions or disk arrays.

Verify Windows Small Business Server Configuration

»  Microsoft SQL Server.. 2000 installed:
« Using Windows authentication
+ Installed as the default instance of SQL Server
« With Service Pack 3a installed
«  With SQL Server Agent and SQL Server services set to Auto-start, and running

« With a backup plan that will include the three databases created by Microsoft CRM:
Organization_MSCRM, Organization_METABASE, and Organization_.CRMCRYSTAL.

« For security, the sample databases shipped with SQL Server deleted (optional)
+ Microsoft Exchange Server 2003 installed and used as the e-mail server
+ Internet Information Services (lIS) installed, and services running
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Choose Installation and Get License Key

You can either set up a demonstration installation that uses Microsoft CRM with sample Adventure Works
Cycle users and data, or you can set up production installation that works with your own users and data.
You cannot have both a demonstration and a production installation on the same server.

Whenever a step in this guide is different between a demonstration installation and a production
installation, you will see the following symbols. If not noted, the step needs to be done for both.

rﬁ) Adventure Works Cycle demonstration installation.

The demonstration installation requires six Active Directory accounts. Only install this if
you have enough Windows Small Business Server licenses.

If you install a demonstration installation, when you are ready to use Microsoft
CRM for your own data, follow the steps in the Appendix to this guide, “Switch from
Demonstration Installation to Production Installation.”

= Production installation.

Get License Key
In order to install Microsoft CRM, you need a license key. Each key is tied to a specific organization name.

% For a demonstration installation, you must use Adventure Works Cycle as the organization
name, and 8QULY9UJ3165WMT5PEFZK as the license key.

For a production installation, you must get a license key from http://www.microsoft.com/
BusinessSolutions/MBSRegistration. The organization name you use when you request a

license key will be required during Microsoft CRM setup.




Install Microsoft CRM Prerequisites

Install Message Queuing and Indexing Service

1
2.

3.
4.

Log on as a domain administrator.

On the Start menu, click Control Panel, click Add or Remove Programs, and then click Add/
Remove Windows Components.

Select Application Server, and then click Details.

In the Application Server dialog box, select Message Queuing, and then click Details.

In the Message Queuing dialog box, clear the Active Directory Integration check box, and then
click OK.

In the Application Server dialog box, click OK to close the dialog box. From the Components list,
select the Indexing Service check box, click Next, and then click Finish.

Close the Add/Remove Windows Components dialog box.

Create Organizational Unit in Active Directory (optional)

Tip: v

Creating an organizational unit (OU) for the Microsoft CRM installation helps keep your Active Directory
organized.

Open Active Directory Users and Computers, right-click your domain, click New, and then click
Organizational Unit. In the Name box, type a name for your OU. For example, Microsoft CRM OU.
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Create a New Web Site for Microsoft CRM

Tip: v

10.

11.

12.

Log on as a domain administrator.

Create a new account to use for installing Microsoft CRM, for example CRMADMIN. This account
must be a member of the Domain Admins group. A Microsoft CRM license is not required for this
account.

On the Start menu, point to All Programs, click Administrative Tools, and then click Server
Management.

Expand Advanced Management, expand Internet Information Services, and then expand the
server.

Right-click Web Sites, point to New, and then click Web Site.
Complete the wizard, using a description such as Microsoft CRM version 1.2.

a. On the IP Address and Port Settings page, select the IP address of the internal (local)
network adapter. This value should appear in the list.

To distinguish between the default Web site and the Microsoft CRM Web site, in the Host
header for this web site box, specify a host-header alias name, such as MSCRM, and then
click Next.

b. On the Web Site Home Directory page, click Make New Folder, and then click Next.
Use a descriptive folder name, such as Microsoft CRM Web.

c. On the Web Site Access Permissions page, click OK to accept the default (Read and Run
Scripts), click Next, and then click Finish.

In Windows Explorer, right-click the folder you created for the Microsoft CRM Web site. On the
Security tab, click Add.

In the Enter the object name to select box, type Domain Users, and then click OK.

In the Server Management window, under Advanced Management, double-click Computer
Management, double-click Services and Applications, double-click DNS, double-click the
Windows Small Business Server computer, double-click Forward Lookup Zones, and then click the
domain name for the Windows Small Business Server network. (Ignore the forward lookup zone
beginning with _msdcs.)

Right-click the primary forward lookup zone for the domain, and then click New Alias (CNAME).

In the New Resource Record dialog box, in the Alias name box, type the host header alias you
created in step 4, MSCRM. In the Fully qualified domain name (FQDN) for target host box,
type the DNS name of the computer running Windows Small Business Server, for example,
SBSSRV.example.office.com, and then click OK.

To verify that DNS is set up properly, at the command prompt, type the following: ping MSCRM,
where MSCRM is the host-header alias name you used for the Web site. If DNS is set up correctly,
you should see replies. If you receive a message that ping could not find MSCRM, go back through
the previous steps in this process to search for any discrepancies.

To verify that the empty Web site is properly set up, create a default.htm page that has one word

on it, and put this page in the folder you set up in step 5. Browse to http://MSCRM/default.htm.
If the Web site is configured correctly, you should see this new page. Once you have verified this,

delete your test page.



Install Microsoft CRM

Run Microsoft CRM Setup

%. 0w~ -

Log on as a domain administrator.
Insert the Microsoft CRM Server CD, and then click Install Microsoft CRM Server.
On the Set Up Licenses page:

For a production installation, type your license number and the organization name you used when
you requested the license.

For a demonstration installation, type the organization name Adventure Works Cycle, type the
license number 8QULY9UJ3165WMTS5PEFZK, and then click Add.

Important: If you install a demonstration installation, when you are ready to use Microsoft CRM
for your own data, follow the steps in the Appendix to this guide, “Switch from Demonstration
Installation to Production Installation.”

Click Next. If prompted, select Install Components, and then click Next to install required
components.

On the Select SQL Server page, from the Server list, click the computer running Windows Small
Business Server. Make sure that Create New Databases is selected, and then click Next.

On the Set Up Organization page, if you want the organizational unit for Microsoft CRM set up at
the top level of Active Directory, click Next. If you have set up an organizational unit that you want
Microsoft CRM installed under, select the location, and then click Next.

On the Select Installation Locations page, in the Web site box, select Microsoft CRM version 1.2,
the name you set up for your Microsoft CRM Web site. For Installation directory, use your default
location for applications.

On the Specify Security Account page, click Next.
After completing Setup, restart the computer.

Verify Microsoft CRM Installation

1.

Verify that the Microsoft CRM Security Service has started. In Administrative Tools, click
Services. Verify that the Status column for Microsoft CRM Security Service shows that the service
is Started. If not, right-click the service, and then click Start. Close the Services window, and then
close Internet Explorer.

Use Internet Explorer on the server, and browse to http://MSCRM. Microsoft CRM should open.
This will be a limited view of Microsoft CRM that does not include the Sales or Service areas, as no
license is yet assigned.

Click Reports, click Admin Reports, click User Reports, and then double-click User List.

The report should run, and you should see a list with one user. Close the report, and close the
browser.

On the Start menu, point to All Programs, point to Microsoft CRM, and then click Deployment
Manager.

If the installation is correct, Deployment Manager should open. Close Deployment Manager.
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Tip:

Set Up Temporary License for Installer

After Setup, Microsoft CRM will have one user, the person who installed Microsoft CRM. By default, no license
is assigned. Without an assigned license, you can add users and configure Microsoft CRM, but you cannot
view or use the Sales and Service areas.

In order to complete the installation steps in this guide, and fully explore Microsoft CRM, you need to have

a Microsoft CRM license assigned to your user in Microsoft CRM. This license can be removed once you are
done installing, so that the installer does not waste a Microsoft CRM license.

When you are done installing and testing the installation, set up another user account with the Microsoft
v~ CRM System Administrator security role and a Microsoft CRM license. This account does not need to be
in the Administrator or Domain Admin groups. Remove the license from the installing user.

Add or Remove a License
1. Use Internet Explorer to go to http://MSCRM. Depending on the browser settings, you may be
prompted to log on to the site.
2. Onthe Home page, click Settings, click Business Unit Settings, and then click Users.

Double-click the only user. Type a value for First Name, Last Name, and Primary E-mail address.
Use your e-mail address so you can use this account for verifying installation.

w

Select a license:

Click Licenses, click Manage Licenses, and then select the Microsoft CRM Suite Professional
license in the left column.

Click Licenses, click Manage Licenses, and then select a license in the left column.

To add a license, click the arrow to move the selected license to the right column. To remove a
license, click the arrow to move it to the left column.

,\
v 0 »

Install Recommended Microsoft CRM Server Updates

To find each of the following updates, go to Microsoft Business Solutions version 1.2 published updates and
hotfixes, available at http://support.microsoft.com/default.aspx?kbid=838986. This page contains links to the
following recommended updates:

834791 Adding, Deleting and Renaming Microsoft CRM Reports Using Microsoft CRM 1.2 Report Manager

840934 Microsoft Business Solutions CRM version 1.2 update for 839153, 839159, and 839162

Change the Crystal Reports Administrator Password
Warning: Because this password is initially blank, failure to change the password will result in a security risk.

1. In Windows Explorer, go to the C:\\Program Files\Microsoft CRM\Tools folder.
2. Double-click Microsoft.Crm.Tools.CrystalAdmin.exe.

3. In the Microsoft CRM Web Site URL box, type http://MSCRM, where MSCRM is the host-header
alias name you created for the Web site.

4. Leave the Old Password box blank, and then type a new password. Be sure to store this password in
a safe location, as you will need to call Microsoft CRM support if you have forgotten this password.



Prepare Microsoft CRM for Use

The steps to prepare Microsoft CRM for use are different for each type of installation. For the
Adventure Works demonstration installation, follow the steps in “Prepare Adventure Works Cycle
Demonstration Installation for Use.” For a production installation, follow the steps in “Add Your Own
Microsoft CRM Users.”

C&D Prepare Adventure Works Cycle Demonstration Installation for Use

1. Open Active Directory Users and Computers, expand the domain, and then expand
Users. On the Action menu, point to New, and then click User. Use fictitious names,
such as Test Userl and Test User2, so that you can easily remove these users from Active
Directory when you are through using the demonstration installation.

2. Backup the Microsoft CRM databases in case a problem occurs during the import of the
demonstration data.
a. In Enterprise Manager, expand Microsoft SQL Servers, expand SQL Server Group,
expand the server name, and then expand Databases.

b. For both Adventure_Works_Cycle_MSCRM and Adventure_Works_Cycle_
Metabase, right-click the database, point to All Tasks, and then click Backup
Database. Specify the destination, and then click OK.

3. On the Microsoft CRM Server CD, navigate to the SampleData folder, and then double-
click Microsoft.Crm.SampleDataWizard.exe.

4. Specify the Microsoft CRM server URL as http://MSCRM.
5. On the Select Users page, select the five new users.
6. Log off, and log on again as one of the five users to see the data for that user.

Add Your Own Microsoft CRM Users

This procedure assumes you already have users set up in Active Directory and Microsoft Exchange.

1. Starting with an organization chart, decide which Microsoft CRM roles are appropriate
for each user. For information about roles, see Appendix B, “Security Role Tables,” in the
Microsoft CRM Implementation Guide.

2. On the Start menu, point to All Programs, point to Microsoft CRM, and then click
Deployment Manager.

3. Expand User Manager, and then expand your organization name from the list.

On the Action menu, point to New, and then click Create CRM Users. Use the User
Manager Wizard to add users with Microsoft CRM roles.

Tip: v You can also add users from within Microsoft CRM: click Settings, click Business Unit Settings,
and then click Users.
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Install Microsoft CRM-Exchange E-Mail Router

If your organization uses Microsoft Exchange Server 2003 as the e-mail server for the organization, you can
use the Microsoft CRM-Exchange E-Mail Router (the Router) to transfer e-mail from Microsoft Exchange Server
to the Microsoft CRM system. Incoming and outgoing e-mail messages can then be tracked as activities within
Microsoft CRM.

Important: Internet access is required to complete the following procedures.

Install the Router

1.

On the Microsoft CRM Server CD, double-click Splash.exe, and then click Install Microsoft CRM-
Exchange E-Mail Router.

On the Specify Microsoft Business Solutions CRM Server page, click Configure, and then click
Add.

On the Add Server page, type the DNS name of the computer running Windows Small Business
Server, type the URL for the Web site, for example http://MSCRM, and then click Next.

On the Specify Security Account page, type the user name (in the provided format example) and
the password of the service account you created for Microsoft CRM. Important: The user name must
be in the format Domain/username. Click Next.

On the Select Installation Locations page, from the Web site list, click the Microsoft CRM version
1.2 Web site, and then complete the setup wizard.

Verify Outgoing E-Mail

4.

Go to http://MSCRM, and log on as the system administrator.

On the Home page, under Create a Record, click Contact, and then set up a new contact with an
external e-mail address to which you have access, such as your personal e-mail address.

In the Contact record, click Send E-mail, type the test subject text, and then click Send. The Router
sends out the e-mail, and the system saves the e-mail as an activity record that you can view in
Activities.

Verify that the e-mail arrived at the external address.

Verify Incoming E-Mail

From the external e-mail account, reply back to the test e-mail sent from Microsoft CRM.
Go to http://MSCRM, and on the Go To menu, click Sales, and then click Contacts.

Double-click the contact you created, and then click Activities. You should see the e-mail message in
the Activity History list. The e-mail message will also appear in your e-mail queue. To view it, click
Workplace, click My Work, and then click Assigned.
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Set Up Client Computers

Client computers access Microsoft CRM in one of two ways:

€

Internet Explorer. To open Microsoft CRM, any client computer with network access to the Windows
Small Business Server can go to http://MSCRM. No software needs to be installed on the client
computer. All data is stored on the server.

Microsoft CRM Sales for Outlook (the Outlook client). Once installed, the user opens Microsoft
Outlooke to view Microsoft CRM data. Data is stored on the client computer so that it is available
when the user is offline. The data is synchronized when the user connects to the network.

The Outlook client should not be installed on the Windows Small Business Server. It can only be installed
once on a computer, and can only be associated with one Outlook profile on the computer. It can only
be used from the client computer, and cannot be used if you remotely connect to the client computer.

This step will take between 10 and 60 minutes, depending on the number of client setups and whether you
are installing the Outlook Client.

If Needed, Set Up Pre-Windows 2000 Compatible Access Group

If you have any client computers on the Windows Small Business Server network that are running Windows operating
systems earlier than Microsoft Windows 2000, you need to set up the Pre-Windows 2000 Compatible Access group.

1.

2.
3.
4.

Open Active Directory Users and Computers, expand your domain, and then click Builtin.
Double-click Pre-Windows 2000 Compatible Access, click the Members tab, and then click Add.
Click Object Types, select Computers, and then click OK.

Type the name of the service accounts you created for Microsoft SQL Server and Microsoft CRM.

Verify Users Can Access Microsoft CRM from Client Computers

On a client computer, browse to http://MSCRM, and log on as one of the following users:

&

If you are using the sample database, log on as a test user.

If you are using your own data, log on as a user that does not have the Microsoft CRM System
Administrator security role.

@3N Verify Client Computers Meet Outlook Client Requirements

12

For each client computer on which you want to install the Outlook Client, make sure the computer and
software meet the following requirements:

Processor Intel Pentium 300-megahertz (MHz) or higher processor, Pentium Ill 1-gigahertz (GHz) processor recommended.

Memory 256 megabytes (MB) of RAM, 384 MB or more recommended.

Operating Windows 2000 Professional, including Service Pack 3, or Windows XP Professional, including Service Pack 2.
System

Do not install on Windows Small Business Server, Windows 95, Windows 98, Windows ME, or Microsoft Windows NTe 4.0.

Microsoft Microsoft Office Professional Edition 2003, or

Office

Other

Microsoft Office Professional Edition XP with Service Pack 2, or
Microsoft Office 2000, including Service Release 1, Service Pack 3, and Post-Service Pack 3 Hotfix 228512.

Internet Explorer 6.01 or later.

Software Indexing Service installed and running, and set to start automatically.

Microsoft Outlook, started at least once, with a valid e-mail account configured.

Network LAN or high-speed VPN access is required to install the Outlook client and for first synchronization.

Access

To verify network access to the Windows Small Business Server computer, in a command prompt on the client
computer, type: NSLookup <Small_Business_Server_computer_name>.




@9 Install Outlook Client
Important: You must log on as the user for whom you are installing the Outlook client. This user account
must be in the Administrator group for the client computer, and must be set up in Microsoft CRM as a user.
1. Verify that the computer is online and that you can connect to the Microsoft CRM Server by
browsing to http://MSCRM. After verifying this, close the browser.

2. Insert the Microsoft CRM Sales for Outlook CD, click Install Microsoft CRM Sales for Outlook,
select Install all required components, and then complete the wizard.

3. Restart the client computer. .

4. If the client computer runs Windows XP Professional with Service Pack 2, install the following
Microsoft CRM update on the client computer:
http://support.microsoft.com/default.aspx?kbid=870635.

5. To configure offline use of the Outlook client, in Control Panel, double-click Administrative
Tools, click Local Security Policy, expand Local Policies, and then select Security Options. In
Windows 2000, set the value in Number of previous logons to a value greater than zero (0).
In Windows XP, set the value in Interactive Logon: Number of previous logons to cache to a
value greater than zero (0).

@EW) Verify Outlook Client Installation
1. Log on as the user and open Outlook. You should see the Microsoft CRM toolbar. In the All Mail
Folders list, click Microsoft CRM and the Home page should display. .

2. Select an e-mail message, and then click Promote to CRM Activity. A Microsoft CRM e-mail
activity appears.

3. Click Go Offline, located next to Promote to CRM Activity, and then click OK.
Click Go Online to verify that you can go online.

Notes:
«  The first offline session takes longer than successive sessions.

«  While offline, some features, such as reports and workflow, are unavailable.
« The Outlook client does not support customer service features.

@) If Needed, Uninstall the Outlook Client
1. Log on as the user who installed the Outlook client, and reconnect to your network to synchronize
data.
2. In Add or Remove Programs, select Microsoft CRM Sales for Outlook, and then click Remove.
3. Select Microsoft SQL Server Desktop Engine (CRM), and then click Remove.

Delete the Microsoft CRM folder located at C:\Program Files\Microsoft CRM, and the database
folder and files located at C:\Program Files\Microsoft SQL Server\MSSQL$CRM.

5. Search for an MSCRM.pst file on the drive where the Outlook client was installed, and if it exists,
delete it.
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Explore Microsoft CRM

Now that you have Microsoft CRM successfully installed, it is time to explore:

Follow the suggestions on these pages to explore Microsoft CRM from various points of view.

For tips, FAQs, chats, and more, visit Microsoft CRM Online at
http://www.microsoft.com/smallbusiness/community/crm.mspx.

From a Microsoft CRM System Administrator’s View

Hw N

Cre )R
s )

Start Microsoft CRM by going to http://MSCRM.
Log on as a user with the System Administrator security role in Microsoft CRM.
On the Help menu, click User’s Guide, and learn about the features of Microsoft CRM.

Explore how to customize Microsoft CRM to match your business terminology and your user’s needs.
On the Home page, click Settings, click System Customization, click Contact, and then click
Customize Form. Try changing a label or removing a field that your users do not need.

While you are in the Settings area, explore the ways Microsoft CRM can be customized for your
business.

Explore how you can automate steps in your sales and service processes.

a. On the Start menu, point to All Programs, point to Microsoft CRM, click Workflow Manager,
and then enter MSCRM, the host header name you used.

b. Select the Opportunity object.

¢. On the File menu, click New, and then enter a name and description for a new workflow rule to
send an e-mail message when an opportunity is entered for more than $1,000. Leave the event
set to Create, and then click Next.

d. Click Insert Condition, and then click Check Condition. Select the If clause, click Insert
Condition, and then click Check Object Condition. Select the estimated value field, select >=,
type 1000, then and click OK.

e. Select the Then clause, click Insert Action, and then click send e-mail. Look up a recipient, pick a
template, or type the text of the message, type a subject, and then click OK.

f. Click Save. Right-click the rule, click Activate, and then close Workflow Manager.

g. In Microsoft CRM, on the Go To menu, point to Sales, and then click Opportunities.

h. Click New Opportunities, and then create an opportunity with Estimated Value greater than $1,000.
i. When you save this opportunity, the e-mail message will automatically be sent.

From a Sales User’s View

Start Microsoft CRM by going to http://MSCRM.

Log on as a user with a Salesperson or Sales Manager security role in Microsoft CRM.

On the Go To menu, click Sales, and then click Contacts. If you are using the sample database, select
Active Contacts in the View list.

If you are using your organization’s data, click New Contact, and then add a contact.

If you have Outlook installed on the same computer, on the Tools menu, click Import, click Contacts,
and then import a few contacts from your Outlook Contacts list.
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Open a contact, click Activities, and then click New Activity. Schedule an appointment with a
contact for later today. Click Home to view the activity.

Click Reports, click Sales Reports, click Contact Reports, and then double-click Contact
Activities and Notes.

Send e-mail to a group of leads, including importing a comma-delimited (.csv) list, creating an e-
mail message, and specifying which leads to whom you want to send the message.

a. On the Tools menu, click Import, click Leads, and then complete the wizard.

b. On the Home page, click Settings, click Template Manager, click E-Mail Templates, and then
click New E-Mail Template. From the Template Type list, select Lead. Type the subject and
text for the e-mail message and the title to appear in the Activity History list, and then click
Save.

c. On the Tools menu, click Advanced Find. In the Find in list, click Leads. Specify a field and
condition, such as City Contains city, and then click Go.

d. On the Actions menu, click Send Direct E-mail. Select the template you created, and then click
Send. The individual e-mails are shown on the Activity History tab for each lead.

EI3) From a Customer Service Representative’s View

1
2.
3.

7.

Start Microsoft CRM by going to http://MSCRM.
Log on as a user with a Customer Service Representative or CSR Manager security role.

On the Go To menu, click Service, and then click Cases. If you are using the sample database, in the
View list, select Active Cases.

Click New Case to add a case.
Save your new case, and click the Close button.

Click to select the case, and then on the Actions menu, click Assign. Assign the case to another
user.

Click Reports, click Service Reports, and then run a few reports.

Before Using Microsoft CRM, Do Required Configuration

Before using Microsoft CRM for real data in your organization, you will need to enter data in several areas to
configure Microsoft CRM to match your organization. To enter this data, on the Home page, click Settings.
For information about each setting, see Microsoft CRM online Help.

0@

Organization: Define business units and roles, enter users, and modify system settings, such as
your fiscal year settings.

Sales: Define territories, quotas, product catalog, sales literature items, and e-mail message
templates.

Service: Define subject hierarchy, queues, contracts, and knowledge base (KB) article templates.

You may also want to import existing business data, or set up workflow rules.

d

i

Existing contacts and leads: If you have existing contact and lead data that you want to import to
Microsoft CRM, you can add contacts and leads using the Import command on the Tools menu.

Other existing data: To import data from an existing database into Microsoft CRM, use the
Microsoft CRM Data Migration Framework, available on PartnerSource and CustomerSource, or use
third-party migration tools (http://www.microsoft.com/BusinessSolutions/crm/crm_isv.aspx).

Business processes: Set up workflow rules to match your business processes.
15
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Appendix:

Switch From Demonstration Installation to Production Installation

Switch from Demonstration Installation to Production Installation

In Add or Remove Programs, select Microsoft CRM, and then click Remove.

Delete all files from C:\Program Files\Microsoft CRM.

In Active Directory Users and Computers, delete the Adventure Works Cycle node.

In the Users node, delete the test users. Close Active Directory Users and Computers.

In Enterprise Manager, expand Microsoft SQL Servers, and then expand SQL Server Group.
Right-click Local (Windows NT) and then click Delete SQL Server Registration. Click Yes.
Right-click SQL Server Group and then click New SQL Server Registration. Click Next.

On the Select a SQL Server page, select the SQL Server name, click Add, and then click Next.

© ® N o VA WNE

On the Select Authentication Mode page, select The Windows Account information | use to log on to my computer.
Click Next.

On the Select SQL Server Group page, click Add the SQL Server(s) to an existing SQL Server group, click Next, click
Finish, and then click Close.

=
=

=
=

. Expand SQL Server Group and expand your server name.

[=
N

. Caution: Perform the following steps only if there are no other databases other than the Adventure Works Cycle Microsoft
CRM databases on this SQL Server instance that are enabled for replication:
a. Right-click Replication, select Disable Publishing, and then click Next.
b. Select Yes, disable publishing on <SQLServer>, and then click Next, click Next again, click Finish, and then click OK.
If there are other databases that are enabled for replication:
a. Expand Replication, and then expand Publications
b. In the Details pane, right-click the following two publications, and then click Delete:
CRMMetaPub_Adventure_Works_Cycle_Metabase:Adventure_Works_Cycle_Metabase
CRMPub-Adventure Works Cycle_MSCRM:Adventure Works Cycle_MSCRM
c. Open SQL Query Analyzer for this SQL Server instance and type the following commands:
exec sp_dboption Adventure_Works_Cycle_ MSCRM, ‘merge publish’, false
exec sp_dboption Adventure_Works_Cycle_Metabase, ‘merge publish’, false
d. Close SQL Query Analyzer.

13. Expand Databases. For each of the following databases, right-click the database, select Delete, and then click Yes:
Adventure_Works_Cycle_ MSCRM
Adventure_Works_Cycle METABASE
Adventure_Works_Cycle CRMCRYSTAL

14. Delete the .mdf and .Idf files corresponding to the three databases from C:\Program Files\Microsoft SQL Server\MSSQL\Data.
Caution: Do not delete all . mdf and .Idf files from this folder, as it will disable Microsoft SQL Server.

15. In SQL Server Enterprise Manager, expand Security, and then expand Logins.
16. Right-click SQLAccessGroup, click Delete, and then click Yes.
17. Right-click SQLRepl, click Delete, and then click Yes. Close Enterprise Manager.

18. Follow the steps “Run Microsoft CRM Setup” found in section 5 of this guide to install Microsoft CRM for a production
installation.

This guide incorporates the experience and knowledge gained from successful Microsoft CRM installations on
Microsoft Windows Small Business Server 2003. It has been test-driven by the following Microsoft Certified Partners:

- Frank Lee, President of Workopia, Inc.

- Guy Riddle, Managing Director of Snapdragon Consulting Pty Ltd.

- Wayne Small, Small Business Server MVP, and Technical Director of Correct Solutions Pty Ltd.

- Jeff Loucks, Small Business Server MVP, and Senior Solution Architect for Available Technology
- Scott Colson, Microsoft CRM MVP, and Vice President of Autonomix, Inc.
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